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Electre III method 
 
The starting point for most outranking methods is a decision matrix describing the 
performance of the alternatives to be evaluated with respect to identified criteria. The 
output of an analysis is an outranking relation on the set of alternatives. An alternative a 
is said to outrank another alternative b if, taking account of all available information 
regarding the problem and the decision maker’s preferences, there is a strong enough 
argument to support a conclusion that a is at least as good as b and no strong argument 
against. 
 
Considering two alternatives a and b, four situations may occur: 
- aSb and not bSa, i.e., aPb (a is strictly preferred to b). 
- bSa and not aSb, i.e., bPa (b is strictly preferred to a). 
- aSb and bSa, i.e., aIb (a is indifferent to b). 
- Not aSb and not bSa, i.e., aRb (a is incomparable to b). 
 
Concordance principle: If a is demonstrably as good as or better than b according to a 
sufficiently large weight of criteria, then this is considered to be evidence in favor of a 
outranking b. 
 
Discordance principle: If b is very strongly preferred to a on one or more criteria, then 
this is considered to be evidence against a outranking b. 
 
 
Terms 
 
- i: index labeling a criterion. 
 
- gi(a): individual partial preference function of the alternative a with regard to the 
criterion i. 
 
- wi: weight of the criterion i. 
 
- Preference threshold [pi]: is a difference above which the decision maker strongly 
prefers a management alternative over all for the criterion i. 
Alternative b is strictly preferred to alternative a in terms of criterion i if  
gi(b) > gi(a) + p(gi(a)). 
 
- Indifference threshold [qi]: is a difference beneath which the decision maker is 
indifferent between two management alternatives for the criterion i. 
Alternative b is weakly preferred to alternative a in terms of criterion i if 
gi(b) > gi(a) + q(gi(a)). 
 
- Veto threshold [vi]: blocks the outranking relationship between alternatives for the 
criterion i. 
Alternative a cannot outrank alternative b if the performance of b exceeds that of a by an 
amount greater than the veto threshold, i.e. if gi(b) ≥ gi(a) + vi(gi(a)). 
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- Concordance index [C(a,b)]: measures the strength of support, given the available 
evidence, that a is at least as good as b considering all criteria. 
Ci(a,b): concordance index over alternative a and b with regard to the criterion i. 
 
- Discordance index [D(a,b)]: measures the strength of the evidence against this 
hypothesis. 
Di(a,b): discordance index over alternative a and b with regard to the criterion i. 
 
- Credibility index [S(a,b)]: measures the strength of the claim that “alternative a is at 
least as good as alternative b”. 
 
 
Algorithm 
 
1- The start point is the decision matrix. The parameters pi, qi and vi have to be defined by 
the user. 
 
2- Calculate concordance index for each criterion: 
 
 0, if gi(b) ≥ gi(a) + pi(gi(a)) 
 
Ci(a,b) = 1, if gi(b) ≤ gi(a) + qi(gi(a)) 
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3- Calculate overall concordance index. 
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4- Calculate discordance index for each criterion: 
 
 
 0, if gi(b) ≤ gi(a) + pi(gi(a)) 
 
Di(a,b) = 1, if gi(b) ≥ gi(a) + vi(gi(a)) 
 

 
(a))(gp - (a))(gv

(a))(gp - (a)g - (b)g

iiii

iiii , otherwise 

 
If no veto threshold (vi) is specified Di(a,b) = 0 for all pairs of alternatives. 
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5- Calculate credibility index: 
 
  
 C(a,b), if Di(a,b) ≤ C(a,b) i∀  
S(a,b) =  

 C(a,b) ∏
> ),(),( baCbaDi b)C(a, - 1

b)(a,D - 1 , otherwise i

  
If no veto thresholds (vi) are specified S(a,b) = C(a,b) for all pairs of alternatives. 
 
6- Determine rank order: 
 
- Descending distillation: 
 
6.1- Determine the maximum value of the credibility index: λmax = max S(a,b). 
 
6.2- Calculate λ = λmax – (0.3 – 0.15 λmax). Where -0.15 and 0.3 are the preset up values of 
distillation coefficients, α and β. 
 
6.3- For each alternative a determine its λ-strength, i.e. the number of alternatives b with 
S(a,b) > λ 
 
6.4- For each alternative a determine its λ-weakness, i.e. the number of alternatives b 
with (1- (0.3 - 0.15λ)) * S(a,b) > S(b,a) 
 
6.5- For each alternative determine its qualification, i.e. the difference between λ-strength 
and λ-weakness. 
 
6.6- The set of alternatives with largest qualification is called the first distillate (D1). 
 
6.7- If D1 has more than one alternative, repeat the process on the set D1 until all 
alternatives have been classified. If there is a single alternative, than this is the most 
preferred one. Then continue with the original set of alternatives minus the set D1, 
repeating until all alternatives have been classified. 
 
- Ascending distillation: 
 
This is obtained in the same way as the descending distillation but at step 6.6, the set of 
alternatives having the lowest qualification forms the first distillate. 
 
- Final ranking: 
 
There are several ways how to combine both orders. The most frequent is the intersection 
of two outranking relations: aRb (a outranks b according to R) if and only if a outranks or 
is in the same class as b according to the orders corresponding to both relationships. 
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Electre IV method 
 
 
The Electre IV exploiting procedure is the same as in Electre III. Moreover, in this case 
there are 5 possible binary relations: 
 
Quasi-dominance: The couple (b, a) verifies the relation of quasidominance if and only 
if: 
- for every criterion, b is either preferred or indifferent to a, 
- and if the number of criterion for which the performance of a is better than the one of b 
(a staying indifferent to b) is strictly inferior to the number of criteria for which the 
performance of b is better than the one of a. 
 
Canonic-dominance: The couple (b, a) verifies the relation of canonic-dominance if and 
only if: 
- for no criterion, a is strictly preferred to b, 
- and if the number of criteria for which a is weakly preferred to b is inferior or equal to 
the number of criteria for which b is strictly preferred to a, 
- and if the number of criteria for which the performance of a is better than the one of b is 
strictly inferior to the number of criteria for which the performance of b is better than the 
one of a. 
 
Pseudo-dominance: The couple (b, a) verifies the relation of pseudo-dominance if and 
only if: 
- for no criterion, a is strictly preferred to b, 
- and if the number of criteria for which a is weakly preferred to b is inferior or equal to 
the number of criteria for which b is strictly or weakly preferred to a. 
 
Sub-dominance: The couple (b, a) verifies the relation of subdominance if and only if: 
- for no criterion, a is strictly preferred to b. 
 
Veto-dominance: The couple (b, a) verifies the relation of vetodominance if and only if: 
- either for no criterion, a is strictly preferred to b, 
- or a is strictly preferred to b for only one criterion but this criterion not vetoing the 
outranking of a by b and furthermore, b is strictly preferred to a for at least half of the 
criteria. 
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Electre III/IV software 
 
 
The Electre III/IV software has been developed between 1992 and 1994 by the Dauphine 
University of Paris and the Institute of Computazionali Sciences of the University of 
Poznan in Polonia. It implements the decision support models Electre III and IV. 
 
Electre III starts with a finite set of actions evaluated on a consistent family of pseudo-
criteria and aggregates these partial preferences into a fuzzy outranking relation. Electre 
IV builds several non-fuzzy outranking relations when criteria cannot be weighted. 
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User manual 
 
 
Edit menu 
 
Project Reference 
 
To visualize or modify some project data (name, description, owner and chosen algorithm 
for the problem solution). 
 
Criteria 
 
To visualize, insert, modify or delete the project criteria and their information (name, 
code, preferences direction and weight). 
  
Alternatives 
 
To visualize insert, modify or delete the project alternatives and their information (name 
and code). 
 
Performances 
 
To visualize or modify the performances table of the alternatives in relation to the 
criteria. This command is not available if the project type is “Matrix of degrees of 
credibility”. 
 
Thresholds 
 
To visualize or modify the coefficients values of the threshold functions on every 
criterion. This command is not available if the project type is “Matrix of degrees of 
credibility”. 
 
The software Electre III/IV allows to modulate the thresholds by means of the 
coefficients α and β of a generic linear function α*g(a)+β, where g(a) means that g is the 
function of the performances of the alternative a. This means that it is possible to insert 
the thresholds as percentages of the performances of the alternatives (α) and/or as 
absolute values (β). 
 
If you have entered alternatives into the project, there will be for each criterion three 
different values: 
 
- Min (gj): indicates the smallest value that has been entered for the selected criterion. 
- Max (gj): indicates the biggest value that has been entered for the selected criterion. 
- Min (Δgj): indicates the smallest difference in values for the selected criterion. 
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Credibility Matrix 
 
To visualize or modify the values of the credibility matrix on which the customers would 
apply the ordering algorithm Electre III. This command is only available if the project 
type is “Matrix of the credibility degree”. 
 
 
Calculate menu 
 
Calculate 
 
To execute the project calculations. 
 
Method 
 
To choose the solution algorithm of the problem (Electre III or IV), and to choose the 
relations that must be used for Electre IV or to modify the distillation coefficients of 
Electre III. 
 
Information 
 
To visualize some project information (number of alternatives and criteria, project state, 
available memory). 
 
Statistics 
 
To visualize statistic information concerning to the result of the Calculate command. 
 
 
Results menu 
 
Distillations 
 
To visualize the project result of the two distillations (ascending and descending). Electre 
III/IV processes the data every time this command is accessed if the Calculate command 
has been previously launch. 
 
In distillation procedure, the ranking is based on the number of alternatives outranked by 
each alternative minus the number of alternatives which outrank it. 
 
Descending distillation: begins with the alternatives with greater qualification. 
 
Ascending distillation: begins with the alternatives with lesser qualification. 
 
In both cases, the effect of the selected alternatives is annulled on the remaining ones. 
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Ranks in Final Preorder 
 
To visualize the alternatives classified through the intersection of the preorders coming 
from the two distillations. This command allows classifying the position of every 
alternative. 
 
Median Preorder 
 
To visualize the alternatives classified from the Median Preorder. This preorder is 
complete and is built in the following way: the alternatives are classified following the 
orderings of the Final Preorder and two incomparable alternatives in the same position 
are classified according to the differences in their positions in the two distillations. 
 
Additional Results 
 
To visualize three types of complementary results: another way to visualize the final 
partial preorder (using a matrix: Ranking matrix), results from immediate calculations 
such as the Concordance Matrix (only for projects executed with Electre III) or such as 
the Credibility Matrix. 
 
The ranking matrix explains only the nature of the relationship in terms of preference, 
indifference or incomparability among the alternatives. 
 
The credibility matrix is a measure of the strength of the claim that “alternative a is at 
least as good as alternative b”. 
 
The concordance matrix is equal to the credibility matrix if no veto thresholds are 
assigned, so the discordance matrices are all zero matrices. 
 
Final Graph 
 
To visualize the graph that represents the partial preorder obtained using the classification 
algorithm of Electre. 
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Example 
 
 
In this section it is described the followed procedure to resolve a problem between chosen 
alternatives with the Electre III/IV software; it comes from the insertion of the data to the 
visualization and printing of the final results. Electre III/IV allows to charge the data 
manually or to import them from rows in ASCII format. In order to import or to export 
the data it is necessary to respect the very precise text formatting rules. If someone wants 
to execute this operation, it is recommendable to read carefully the content of 
README.ASC file.  
 
During all the procedure is available a contextual guide which you can access pushing the 
Help button situated in most of the dialogue windows. With the F1 key it is always 
possible to recall the general index of the guide.  
 
 
Creating a new project 
  
Once the Electre III/IV program it is started select “New Project” from the “File” menu. 
It will appear the “Created New Project” window, from which it is possible to choose 
“Define new data set”, in order to insert a new one with your data, or “Browse existing 
data sets” in order to recall of the data already stored (“eld” file extension); we select 
“Define new data set”.  
 
The window “Edit Project Reference” will appear, on that window we can choose the 
algorithm to solve the problem and it is also possible to insert the name of the customer 
and one short description of the project. With the mouse select Electre III. 
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Inserting the criteria 
 
On the main window select “Criteria” from the “Edit” menu to insert the criteria to 
evaluate the alternatives: the window “Edit Criteria Table” will appear. Click on Insert 
and proceed to the insertion of the name and the weight of the first criterion. 
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Fill up the name of the criterion, its weight and the direction of the preference. The 
weight represents the importance of the criterion on the object regarding the others 
criterions. It is possible to insert weights between 0 and 100, being allowed the use of 
float number too. The direction of the preference specify if the criterion is increasing, like 
for example a price (greater is the score of the criterion, better is the satisfaction of the 
decision), or decreasing, like for example a cost (smaller is the score of the criterion, 
smaller is the satisfaction of the decision). To every criterion it comes associated a 
identification code of 4 characters (Cr01, Cr02, …) that it can be modified by the 
customer.  
 
Once it is finished the insertion, the inserted criteria can be modified or cancelled 
selecting them from the list of the window “Edit Criteria Table”. 
 
 
Inserting the alternatives 
 
Select “Alternatives” from the “Edit” menu. The window “Edit Alternatives Table” will 
appear from which it is possible to insert new alternatives. To each alternative it comes 
associated a identification code of 5 characters (A0001, A0002, …). When the insertion it 
is finished, it is possible to modify or to cancel the inserted alternatives selecting them 
from the list of the window “Edit Table Alternatives”. 
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Modifying the performances 
 
Select “Performances” in the “Edit” menu. The window “Edit Performances Table” will 
appear, that window shows the spreadsheet of alternatives (lines) and criteria (columns) 
said appraisal matrix. To type (modify) the value of a cell, you may either click on this 
cell or move to it with the arrow keys. 
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 It is possible to insert numbers six digits long, decimals included. Therefore it is allowed 
the values between -999,999 and +999.999. The Close button stores the inserted data and 
closes the dialogue window.  
 
 
Inserting the thresholds  
 
Select the command “Thresholds” in the “Edit” menu, then, either double-click on the 
criterion whose parameters you wish to modify, or activate this criterion and click on 
Modify. It is possible to insert the coefficients of indifference, preference and, optionally, 
veto thresholds. 
 
In the example, if for the criterion Cr01 the alternative A0001 has the performance 100, 
the alternative A0002 has the performance 110 and the indifference threshold q = 
0.1*g(a)+5, then q(g) will be equal to 15 for the alternative A0001 and 16 for A0002. In 
other words, a difference of 15 points regarding the criterion Cr01 is not meaningful in 
order to judge A0001 indifferent to the other alternatives (in this single case A0002) and a 
difference of 16 points is not meaningful in order to judge A0002 indifferent regarding 
the other alternatives (in this case A0001). With the same procedure we can fill up the 
preference p and veto v thresholds. 
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Calculating the data 
 
Once inserted the data (criteria, alternatives, performances and thresholds) select 
“Calculate” in the “Calculate” menu in order to calculate the data. A dialogue window 
will appear with statistics information about the calculations carried out. Selecting 
“Method” in the “Calculate” menu and after “Advanced” it is possible to modify the 
coefficients of distillation of the Electre III algorithm. It is advised not to modify the 
preset up coefficients (α = -0,15 and β = 0,3). 
 

 

 
 
Selecting the commands “Information” and “Statistics” in the “Calculate” menu it is also 
possible to visualize other information relative to the running project and the memory 
available. 
 
 
Visualizing the results 
 
Selecting “Distillation Result” in the “Results” menu it is possible to visualize the 
ascending and descending graphs of the alternatives. 
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Selecting “Ranks in Final Preorder” in the “Results” menu it is possible to visualize an 
intersection of the two previous graphs. 
 

 
 
Selecting “Final Graph” in the “Results” menu it is possible to visualize the final graph. 
 

 
 
This example means that the alternative A0004 is preferred to A0002 and A0003, and 
therefore A0004 is preferred to A0001 and A0006. 
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Conclusions and future work 
 
 
At first we had problems to understand how Electre III/IV works due to the lack of 
related information, but finally we have found out the whole algorithm joining 
information from several sources. 
 
We have found some restrictions in Electre software, for example it only accepts numeric 
values for the criteria and it is limited to datasets with the extension “.eld”, so we have 
not been able to test our own dataset. Moreover, we have had to use the demo version, 
and it only accepts up to 5 criteria and 6 alternatives. 
 
Following the work of the other group we have seen the differences between Electre 
III/IV and Electre Tri software. The main difference is that Electre Tri uses profiles to 
compare with the alternatives and evaluate them, and Electre III/IV does not have this 
option. 
 
As future work, once we know how Electre III/IV works, it would be possible to create 
an alternative software package with the same functionalities and with an improved 
graphic user interface. We recommend implementing it with Java programming language 
to allow the execution of the software in any platform supporting the Java Virtual 
Machine. This software would be licensed under GPL, allowing everybody to view and 
modify the source code and therefore understand the procedure of the algorithms. This 
type of license will protect this software against future copyrights and shareware 
restrictions (demo programs). 
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